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Chapter 1: About This Manual
This manual describes visualization features in Ansys Chemkin, the Visualizer, and other post-processing
alternatives. The Graphical Post-Processor (p. 7) focuses on the Chemkin Visualizer, which is launched
from the Chemkin Interface. Post-Processing Alternatives (p. 27) provides additional post-processing
options, including the Export Solution Utility (GetSolution.exe) and the Export to Excel options. Reaction
Path Analyzer (p. 37) discusses the Chemkin Reaction Path Analyzer, which provides visualization of
the inner workings of the chemistry model and fundamental understanding of reaction mechanism
dependencies.

1.1. Overview of Solution Data Available from CHEMKIN

The objective of post-processing is the analysis and/or extraction of data obtained from the Ansys
Chemkin simulations. The analysis may be as simple as comparing a set of scalar values or may require
2-D and 3-D plotting and contour capabilities. In some cases, we want to make derived calculations
based on the raw Chemkin outputs.

There are three types of outputs produced by the Ansys Chemkin reactor simulations:

• Solution File (zip file).

This file, which by default is named XMLdata_<project_name>.zip, is a compressed, XML-formatted
text file comprised of multiple blocks of information. The information includes the independent and
dependent variables in the system as well as any sensitivity data that was requested in the problem
setup.

By using an XML format, we provide a generalized format that all of our reactor models can read and
write. Each Solution File is comprised of a header block and multiple data blocks. Each block (XM-
Ldata1.zip, etc.) is compassed, separately, but the blocks must be read consecutively and seamlessly
to process the entire file as an XML-formatted stream. The Ansys Chemkin installation includes such
a SAX-based XML parser program which is used by our simulation, export, and post-processing pro-
grams when working with the Solution File. The purpose of breaking the file into multiple zipped
blocks is to allow large data sets to be compressed into smaller files without overwhelming the machine
resources for memory during the file operations.

There are a number of derived values calculated as part of the post-processing. These values are not
found within the Solution File itself and are created on the fly, using the solution data and the Ansys
Chemkin utilities. Table 1.1: Output Variables Created by Derived Calculations in the Visualizer (p. 2)
lists the derived variables that are routinely or optionally calculated for the applicable reactor models.

• Diagnostic Output File (.out).

A text file listing the simulation inputs, the progress of the solution and some or all of the outputs.
This is useful for a quick inspection/review and also contains any error messages generated by the
application. The diagnostic output file should not be used for any post-processing or batch processing,
as the format of the output is not a fixed format and may vary from one solution to another.

1
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• Pre-parsed, comma-separated input files for the Visualizer (.ckcsv).

These files are created by the post-processing step of the Parameter Study facility. They contain the
aggregation of results from multiple parameterized runs of the simulation. These files are in a special
format that is easily loaded by the Visualizer. They contain the derived values, as requested, that are
detailed in Table 1.1: Output Variables Created by Derived Calculations in the Visualizer (p. 2) .

Note:

Note that including sensitivity data or rate-of-production data during post-processing may
result in problems involving too much memory requirements during the solution processing.
For large mechanisms, consider reducing the amount of sensitivity data using the "SEN" option
as described in the Chemkin Input Manual and selecting only a subset of sensitivity or ROP
data during data selection for solution post-processing.

Note:

If your objective is to extract the Ansys Chemkin results as an intermediate step to pass to
an external program or scripting step, we provide data extraction utilities that can extract
all or a subset of Solution File data into either a parsed file (.ckcsv) or further into multiple
comma-separated values files that are easily loaded into Excel or other 3rd-party utilities.
Please refer to the information on command-line and batch-programming options for extract-
ing solution file information.

Table 1.1: Output Variables Created by Derived Calculations in the Visualizer

Applicable
Reactor
Models

DefinitionVariable

AllGas-phase species mass fractions, based on the total
moles of the gas minus water vapor.

Dry
Mass
Fraction

AllGas-phase species mole fractions, based on the total
moles of the gas minus water vapor.

Dry
Mole
Fraction

IC EngineThe indicated mean effective pressure. IMEP considers
only the work done between IVC and EVO in the IMEP

IMEP

calculation. The definition is consistent with indicated
work and indicated power. There is no assumption
about the cycle. IMEP is calculated as:

(1.1)

in which  is indicated work,  is the displacement
volume, calculated as:

(1.2)
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Applicable
Reactor
Models

DefinitionVariable

IC EngineThe indicated work of a cylinder is given by the
average product of the normal force on the face of

Indicated
Work

the piston and the piston velocity. It is calculated as
the integral of PdV, where P is the pressure and dV is
the differential volume.

For a description of cycle/gross indicated work, see
the tutorial,"Spark-Ignition Engine Simulation for
Knock," in the Chemkin Tutorials.

AllMass averaged enthalpy of mixtureMixture
Enthalpy

All Closed
Homogeneous,

Percentage conversion of gas-phase species based on:
(1) initial and final mole fraction in the case of a closed

Molar
Conversion

PSR, PFR, andreactor, or (2) inlet and outlet mass flux in the case of
an open reactor. Shear Flow

Reactors

AllThe net heat production from a gas-phase reaction is
the sum of the rate of heat production from all

Net
Heat

gas-phase species involved in this reaction. The rateProduction
of heat production from a gas-phase species in afrom
reaction is the product of the contribution of theGas-Phase

Reactions reaction to the production rate of the species and the
enthalpy of the species.

Opposed Flow
Flame and CVD
Reactors

Local rate of change in the axial velocity with respect
to distance.

Normal
Strain
Rate

All Closed
Homogeneous,

The Gas-phase volumetric fraction of CO expressed in
parts per million, after removing the volumetric
contribution of water.

Parts
Per
Million PSR, PFR, and
CO Dry
Basis

Premixed Flame
Reactors

All Closed
Homogeneous,

The Gas-phase volumetric fraction of CO expressed in
parts per million, after removing the volumetric
contribution of water and correcting to 15% Oxygen

Parts
Per
Million PSR, PFR, and
CO Dry
Basis
15% O2
Correction

Premixed Flame
Reactors

All Closed
Homogeneous,

The Gas-phase volumetric fraction of NO expressed in
parts per million, after removing the volumetric

Parts
Per

PSR, PFR, andcontribution of water. The defining equation is the
analogous to the equation for CO.

Million
NO Dry
Basis

Premixed Flame
Reactors

All Closed
Homogeneous,

The Gas-phase volumetric fraction of NO expressed in
parts per million, after removing the volumetric

Parts
Per
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Applicable
Reactor
Models

DefinitionVariable

Million
NO Dry

PSR, PFR, and
Premixed Flame
Reactors

contribution of water and correcting to 15% Oxygen.
The defining equation is the analogous to the equation
for CO.Basis

15% O2
Correction

All Closed
Homogeneous,

The Gas-phase volumetric fraction of NOx expressed
in parts per million, after removing the volumetric

Parts
Per

PSR, PFR, andcontribution of water. The defining equation is theMillion
Premixed Flame
Reactors

analogous to the equation for CO, but NOx includes
the volumetric contributions of NO, NO2 and N2O.

NOx
Dry
Basis

All Closed
Homogeneous,

The Gas-phase volumetric fraction of NOx expressed
in parts per million, after removing the volumetric

Parts
Per

PSR, PFR, andcontribution of water and correcting to 15% Oxygen.Million
Premixed Flame
Reactors

The defining equation is the analogous to the equation
for CO., but NOx includes the volumetric contributions
of NO, NO2 and N2O.

NOx
Dry
Basis
15% O2
Correction

AllSpecies rates of production are calculated based on
the local chemical state at each time or position point

Rate of
Production

in the solution. Values are given in per-volume units
for gas-phase reactions and per-surface-area for surface
reactions. Contributions to net species production rates
by each reaction or total production rates can be
selected. Note that selecting to include contributions
from all reactions may result in too much data to
process in the Visualizer, so should be used with
caution when the mechanism is large.

AllMass averaged enthalpy minus mass averaged enthalpy
at STP.

Sensible
Enthalpy

Opposed Flow
Flame and CVD
Reactors

Local rate of change in the "scaled" radial velocity (v/r)
with respect to distance.

Shear
Strain
Rate

AllThe speed of sound traveling through the mixture.Speed
of
Sound

All Closed
Homogeneous,

The Unburned Hydrocarbons (UH) value is defined asUnburned
Hydrocarbons

PSR, and PFR
Reactors
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Applicable
Reactor
Models

DefinitionVariable

where nC i is the number of carbon atoms per

molecule in species i, and X i is the mole fraction of

species i. Here, hydrocarbons are those molecules that
contain one or more of both the elements carbon (C)
and hydrogen (H), and no other elements.

AllThe Volatile Organic Compounds (VOC) value is defined
as:

Volatile
Organic
Compounds

where nC i is the number of carbon atoms per

molecule in species i, and X i is the mole fraction of

species i. Here, a volatile organic compound is defined
as a species containing one or more of both the
elements carbon (C) and hydrogen (H), but the
molecule may include other elements, such as oxygen
(O) or nitrogen (N).
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Chapter 2: The Graphical Post-Processor
The Visualizer is launched from within the Ansys Chemkin interface from the Analyze Results panel,
using the Plot Results option, with the Use Chemkin Visualizer option checked. The basic workflow
for visualization is to load .ckcsv or .csv file(s), display plots, and optionally export a subset of data
for subsequent use. The Chemkin Visualizer does not directly read or process Chemkin solution files
(XMLdata.zip) because the Analyze Results capability in the Chemkin interface handles this task. This
chapter describes how to operate the Visualizer to accomplish these tasks:

• Choose data for graphical display

• Edit the properties of a plot

• Choose from available data sources

This section provides a more complete description of the elements of the Ansys Chemkin Graphical
Visualizer. The information here includes descriptions of menus and buttons as well as hints on program
features.

2.1. Overview of Interface

2.1.1. Control Panel

The Ansys Chemkin Visualizer provides a control panel for creating line and contour plots, including
defining the plot style criteria, and exporting the plot data. Once plot data have been loaded, the
tabs of this plot control panel are displayed, as shown in Figure 2.1: Line Plot Tab (p. 8). If you Cancel
during the initial load of plot data, the panel’s tabs are not shown until you use the File > Open or
File > Import CSV Data Plot command.
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Figure 2.1: Line Plot Tab

Once data are loaded, the control panel’s tabs are presented with the Line Plot tab active. This panel
is described in detail in the following sections. In addition to these tabs, there are drop-down menus
(File and Help) and a data-loading status window at the bottom of the control panel.

2.1.1.1. Menus/Navigation

The menu bar located at the top of the control panel has two menus: File and Help. These are
described in the following sections.

2.1.1.1.1. File Menu

The File pull-down menu is located at the left end of the Ansys Chemkin Visualizer menu bar.
There are three operations available in the Visualizer: Open, Import CSV Data, and Exit. These
are described below.

• Open Option

The Open option allows you to open an exported solution data set having a .ckcsv file extension.
These files are described in Overview of Solution Data Available from CHEMKIN (p. 1). Selecting
the Open option displays a file browser on your computer for selecting an existing solution
file. Once the file (or multiple files) is selected, the program will attempt to read the data in
the file. If there are any difficulties reading the file, a message will appear in the Message Box
at the bottom of the Chemkin Visualizer window.
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• Import CSV Data Option

You can import x-y data from plain text files into the Ansys Chemkin Visualizer using the Import
CSV Data option in the File menu. The import utility expects to find columns of data, delimited
by commas. Selecting the Import option opens a dialog box where you can identify how the
file header information is provided. If you click OK to read in the data and the import utility
encounters errors reading the specified format, you will receive a message in the Message Box,
and the data will not be imported.

• Exit option

The Exit option will exit the Ansys Chemkin Visualizer.

2.1.1.1.2. Help Menu

The Help menu contains a link to open Ansys Chemkin Online Help and documentation at the
Ansys Help site.

2.1.1.2. Messages

The Message Box, located at the bottom of the control panel, helps you to follow the progress of
the post-processing steps. The messages tell you what command is being executed, when it has
finished executing, and whether or not the process has completed successfully.

2.1.2. Control Tabs

Within the Control panel, below the menu toolbar, are a series of Control Tabs from left to right that
allow switching between different control panels. The default control tab is the Line Plot tab. The
Contour Plot tab allows 3-D contour data to be displayed. The remaining Control Tabs allow export
of the data that is being considered in the plotting session and a read-only display of the data files
that have been opened for use. Details on the inputs for each of these Control Tabs are in the following
sections.

9
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Overview of Interface

https://ansyshelp.ansys.com


2.1.2.1. Line Plot Tab

Line Plot Type

Figure 2.2: Line Plot Tab

• Include Variables from Other Plot Sets - By default, only variables for a single plot set are
available for selection. For instance, slice1 may contain distance (or time) and several dependent
variables, such as mass fractions, temperature, pressure, etc. Any 2 variables can be used to create
an XY line plot. In some of the 1-D reactor models and in parameter studies, there may be many
plot sets created; such as slices at varying distances along a shear-layer flow channel or a solution
set that just contains wall data as a function of axial distance. As long as the dimensions of the
solution sets are compatible, you can plot solutions from different solution sets on the same plot.
To do that, use the Include Variables from Other Plot Sets check box near the top of the tab.
Clicking this box will activate a message dialog that allows you to specify more than one plot
set from which to select XY variables. Only those plot sets with the same number of items will
be available for selection, as shown in Figure 2.3: Select Additional Plot Sets dialog (p. 11):
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Figure 2.3: Select Additional Plot Sets dialog

• X Filter - Narrows the list displayed for X Variable to only those variables whose names start with
the string typed into the filter.

X Variable - The independent variable for the XY line plot.

Y Filter - Narrows the list displayed for Y Variable to only those variables whose names start with
the string typed into the filter.

Y Variable - The dependent variable(s) for the XY line plot(s). You can select one or multiple Y
variables to plot against the X variable.

Grouping Variable - This drop list allows you to select a 3rd variable (neither X nor Y) from the
same plot set (or merged plot sets), which will be used to subdivide the XY plot points into
multiple plot line segments. Use the Create New option within the drop list to define a new
grouping variable. Figure 2.4: Select Grouping Ranges dialog (p. 12) shows an example dialog
with Temperature selected to be the grouping variable.
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Figure 2.4: Select Grouping Ranges dialog

• The resulting plot of Solution No. versus Mole fraction H Figure 2.5: Plot lines resulting from
multiple range start points (p. 13) (Figure 2-4) shows that adding two range start points (in ad-
dition to the Min value, which always starts the first range) results in three plot line segments.
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Figure 2.5: Plot lines resulting from multiple range start points

• Sort on X - Check this box to cause the X variable to be sorted (only for this plot). Most Ansys
Chemkin independent variables are already sorted, but imported data may not be sorted. Since
the line plot is essentially a connection of line segments from one XY point to the next, you may
need to sort the X variable in some cases.

Plot Style - The default Standard plot style can be supplemented by as many alternative plot
styles as you would like using either Create New style or the Copy button to make a copy of the
Standard style and then modify it. The Plot Style dialog is described more fully in Section 2.1.2.2.

Use Custom Plot Lines - This setting supplements the Plot Style and allows even more control
over how each plot line is displayed. This dialog is also described more fully below.

Plot Target - By default, each plot is displayed in a new window. For line plots, you can select
to have the plot line(s) added into an existing plot window by selecting the specific plot name
from this droplist. If you choose a different Plot Style or Custom Plot Lines setting, these style
and settings are applied to all the plot lines including those previously plotted.
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2.1.2.2. Plot Style Dialog

The Plot Style dialog allows you to define the way your plot lines, axes, labels, and other elements
are rendered. You have much more ability to control the rendering as the plot is being generated
than once the plot window is created, and you can save your style choices for reuse. The Plot Style
dialog panel has three tabs, as shown in Figure 2.6: Plot Style dialog (p. 14).

Figure 2.6: Plot Style dialog

2.1.2.2.1. Plot Lines tab

Standard Plot Lines or Custom Plot Lines - The first choice is whether to use Standard Plot
Lines or Custom Plot Lines. The standard plot lines style option allows you to select either
constant colors or select a color "wheel" (a list of colors that are used in succession for the 1st,
2nd, … lines of a plot). You can choose whether lines, symbols, or both are displayed and control
the line thickness. The symbol wheel behaves analogously to the color wheel. The Custom Plot
Lines option uses a special custom plot lines style (a named Custom Plot Lines style) defined
in a separate dialog. This controls the color, symbol, line style, etc., for each plot line separately
and gives you maximum control in defining your plot appearance.

• Color Method - This drop-list allows you to select from either a constant color or using the
color wheel. The Edit Color Wheel button allows you to modify the color wheel values and
select different colors to be used. There is only one color wheel, so this change affects all future
plots generated using the color wheel. The Integer drop-list on the right is the starting point
within the Color Wheel for the first plot line. You can specify this differently within each Plot
Style if you wish to do so. Since the Color Wheel has 18 colors and you are unlikely to create
plots with that many lines, you can use this to employ different segments of the Color Wheel
in different Plot Styles. Click on the Color Swatch you prefer for each of the 18 colors shown
in the numbered list. You can select 18 different colors or reuse colors by clicking on the same
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swatch. You can use the HSB or RGB tabs to specify the colors numerically. See Figure 2.7: Color
Editor (p. 15).

Figure 2.7: Color Editor

Plot Lines - Use this to show or hide the plot lines. If you selected the Constant Color option
for Color Method, then specify that color here. You can also choose the line style that will be
used for all plot lines when this Plot Style is used.

Plot Symbols - Use this to show or hide the plot symbols. Use the Edit Symbol Wheel button
to show a dialog that allows you to select the order in which the plot symbols are assigned to
plot lines.

Figure 2.8: Symbol Editor
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• Selection (of Custom Plot Lines) - Use this to select an existing Custom Plot Lines style ele-
ment or use Create New to define a new Custom Plot Lines style. This custom style element
allows a different plot line style for each plot line, as shown here:

Figure 2.9: XY Custom Plot Line Style Editor
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2.1.2.3. Contour Plot Tab

Contour Plot Type

Contour Set - The set contains a consistent set of data that can be used for constructing a contour
plot. Specify the X, Y, and Z dimension values.

X Filter - Narrows the list displayed for X Variable to only those variables whose names start with
the string typed into the filter.

X Variable - The first independent variable for the contour plot. For contour plots, the X and Y
axis choices are vectors and the Z choice is a 2-D plane of points corresponding to the X/Y values.
Only one choice may be made for the X variable from a drop-list of choices.

Y Filter - Narrows the list displayed for Y Variable to only those variables whose names start with
the string typed into the filter.

Y Variable - The second independent variable for the contour plot. As shown above, this is a drop-
list field for selecting the Y axis of a contour plot.

Z Variable - The dependent variable for a contour plot. This is a 2-D plane for contour plot and
only one selection can be made per contour plot. No over-plotting of contour plots is allowed.

Contour Name - The name of the plot created for display on the plot and for contour plot history
file.

Contour Subtitle - A smaller font subtitle can also be displayed on the contour plot.

Create Contour - This button triggers the creation of a new window containing the requested plot.

Figure 2.10: Contour Plot tab
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2.1.2.4. Export Variables Tab

The Export Variables tab allows you to export subsets of XY line plot data from the current session.
An example of the Export Variables tab is shown in Figure 2.11: Export Variables Tab - Export Line
Plot data to CSV file (p. 18). The possible operations that can be performed on the data from this
panel are described in the following descriptions.

Figure 2.11: Export Variables Tab - Export Line Plot data to CSV file

Include Variables from Other Plot Sets - By default, only variables for a single plot set are available
for selection. Clicking this box will activate a message dialog that allows you to specify more than
one plot set from which to select variables. Only those plot sets with the same number of items
will be available for selection, as shown in Figure 2.3: Select Additional Plot Sets dialog (p. 11).

• Filter - Narrows the list displayed for Variable to only those variables whose names start with
the string typed into the filter.

• Variables - Variables to export from the plot set(s)

• Data Type and Variable choices - The choices displayed here are the same choices as those
provided in the Line Plot Tab (Plot Lines tab (p. 14)): Line Plot or Contour Plot, along with se-
lecting Plot Sets and variables.

• Units - The header row and units format choice determines the format of the exported file.

• Export button - Launches a file selection dialog that allows selection of the file (new or existing)
that will receive the exported data. If the file already exists, it will be overwritten, not appended.
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2.1.2.5. Files Tab

This tab simply presents a reference list of the data files that have been loaded into the Visualizer
session. If all of the plot/contour sets loaded from a file are freed from memory, the file will still be
listed. This information is provided here as a cross-reference to the file numbers used when displaying
the Contour Set and Plot Set choices.

2.1.3. Selecting Results to Load from a Solution File

When you click the Analyze Results option on the Ansys Chemkin Interface (see Post-process the
Solution in the Chemkin Getting Started Guide) or when you open a solution file from within the
Chemkin Visualizer, the Select File and then the Select Results to Load from Solution File dialogs will
appear. This dialog (see Figure 2.12: Results to Import—Solution Sets (p. 20)) is divided into three
tabs: Solutions Sets, Species/Variables and Units of Measure.

The dialog also contains two action buttons, OK and Cancel. OK will proceed to the Visualizer Control
Panel. Cancel will exit out of the Ansys Chemkin Visualizer.

The Solutions Sets tab is displayed by default. If Ansys Chemkin produces only one solution set, the
dialog will instead display the Species/Variable tab and the Solutions Sets tab will be disabled. Each
tab is described in the sections below.

2.1.3.1. Solution Sets Tab

The Solutions Sets tab shown in Figure 2.12: Results to Import—Solution Sets (p. 20) allows you to
choose which solution set you would like to plot.
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Figure 2.12: Results to Import—Solution Sets

The None/All toggle button allows you to select or deselect all the solution sets at one time. Addi-
tionally, there is a series of check boxes next to each of the individual solution sets available from
the Ansys Chemkin solution. The check boxes can be selected individually or the None/All toggle
button can be used for global selections.

2.1.3.2. Species/Variables Tab

The Species/Variables tab shown in Figure 2.13: Results to Import—Species/Variables (p. 21) allows
you to select the specific data to be loaded into the Ansys Chemkin Visualizer. The tab includes
several methods for selecting data, including the Global Controls, Data Options check boxes,
Top/Bottom Controls and the Fraction Range Filter areas.
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Figure 2.13: Results to Import—Species/Variables

2.1.3.2.1. Global Controls

The global controls consist of toggle buttons that allow you to quickly select or deselect species
and variables you wish to plot. Depending on the Ansys Chemkin reactor model there will be
four toggle buttons:

• Clear All Check boxes toggle button deselects all the species and variables. This can be useful
if you only want to select a few items.

• No Vars/All Vars toggle button selects or deselects all items in the Species/Variable column.
The Species/Variable column lists all the available species or other variable data.

• No Sens/All Sens toggle button select or deselects all items in the Sensitivity column, when
sensitivity data are available.

• No ROP/All ROP toggle button selects or deselects all the items in the Rate of Production
column. This column allows selection of rates of production contributions of reactions to each
species by name. You may need to scroll the dialog to find a specific species in the list.

Depending on the output created by an Ansys Chemkin reactor model, some of the columns
may not appear. For example, if sensitivity output was not selected in the Chemkin interface
prior to generating the Chemkin Solution, the dialog will not include a Sensitivity column (as in
Figure 2.13: Results to Import—Species/Variables (p. 21)).
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2.1.3.2.2. Data Options Check Boxes

The Species/Variables tab lists all the data that can be plotted by the Ansys Chemkin Visualizer
with a check box to the left of each row or item within the row that can be selected or deselected
to produce a specific data element. The first column allows selection or deselection of a row in
the data set and the other check boxes can the be selected or deselected on an individual basis.

In addition to the variables calculated as part of the Ansys Chemkin solution, there are many
derived calculations listed. These include species net rates of production (ROP), net rate of progress
of reactions (net_reaction_rate), and in some cases, molar conversion of principal components.
When ROP is selected for a species, the net rates of production of that species for each reaction
will be included in the data for post-processing, subject to the filters in the Top/Bottom Controls.
When net_reaction_rate is selected, the net rate of progress of all reactions will be included in
the data for post-processing (these are not subject to the Top/Bottom Controls). Rates of pro-
duction and rates of progress of reactions are defined in detail in the Chemkin Theory Manual.

Selecting molar conversions will result in the calculation of molar conversion rates for any species
that has an initial or inlet mole fraction greater than 1.E-9. The molar conversions are simply
defined as the percent change in mole fraction and therefore do not account for changes in total
moles of the system due to large temperature or pressure changes. This latter calculation is useful
in isobaric systems where gas-phase temperature changes are small. For reactor models that
provide temporal or spatial data, the molar conversions are also provided as a function of time
or distance.

2.1.3.2.3. Top/Bottom Controls

The Top/Bottom Controls allow filtering of the values of species fractions (Species), reaction
sensitivity (Sens) or species rates of production (Rates of Prod) that will be brought into the
Visualizer. You may select the Top (or Bottom) values (for example, the 10 species with the largest
mole fractions). The number can be specified in the available text box (default is 10), while the
All/Top/Bottom toggle button determines how the data will be filtered.

Note:

When you select top/bottom #N species in the post-processor for a transient problem,
it picks the N number of species based on their maximum values throughout the reac-
tion time. For example, at one point in time, species A may be present in very high
amounts but species B may be high later in the reaction. Then maximum levels of
both A and B will be used to order the top or bottom order of species.

2.1.3.2.4. Mole Fraction Range Filter

The Mole Fraction Range Filter provides an alternate method to selecting species for importing
data into the post-processor. Here, you can select the range of species mole fractions in decades.
Use either the Minimum and Maximum slider controls or type directly into the text boxes.

2.1.3.3. Units of Measure Tab

The Units of Measure tab shown in Figure 2.14: Results to Import—Units of Measure (p. 23) allows
selection of the units of measure for the plot data. This tab consists of some Global Controls, as
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well as controls of individual items. The default settings are based on User Preferences set in the
Ansys Chemkin Preferences panel for the Visualizer.

Figure 2.14: Results to Import—Units of Measure

2.1.3.3.1. Global Controls

The global controls allow selection of a global system of units based on centimeter/gram/second
(cgs), Système International d’Unités (SI) or British Units standards of measurement. Choose either
one by clicking the (cgs) or (SI) or British buttons. These buttons will select a predetermined set
of unit options in the list below, overriding any custom selections that were previously made.

2.1.3.3.2. Unit Options

You can customize the units of measure using a series of drop-down lists in the Unit Options
area. These options temporarily override your default settings during the post-processing session.
Default settings are controlled by the Preferences panel in the Ansys Chemkin Interface, as de-
scribed in Managing Preferences.

2.2. Modifying Plot Displays

You can modify a line plot, once displayed, by using mouse motions to reposition the plot or using the
context menu that appears when you right-click on the plot display. The context menu is not sensitive
to your mouse position within the plot; there is only one context menu for line.

The context menu offers the following choices:

23
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Modifying Plot Displays



Figure 2.15: Line Plot—Context menu

2.2.1. Properties…

The Properties… choice brings up a multi-tab properties panel that allows you control over the axes
displays and the plot title. The ability to modify the plot axes tick marks is especially useful and is
not offered within the plot style options. Since these options are very straightforward, no further
description is provided here. Briefly experiment with these options to see their impact. However, note
that the context menu is only aware of the first plot line and hence the first Y axis. If you have selected
to plot multiple Y values, you will need to use the style option of the plot selection panel to exert
control over all the Y axes.

2.2.2. Save as…

The Save as… option allows you to save the plot as a .png format file.

2.2.3. Print…

The Print… option allows you to print the plot.

2.2.4. Selecting the Data Range (Region of Interest)

The remaining three options of Zoom In, Zoom Out, and Auto Range all control the region of interest.
You can use a mouse rubber banding motion to select a region of interest. You can continue to refine
that region of interest in successive rubber banding motions. You can undo those selections using
the context menu's Zoom Out or Auto Range.

2.3. Modifying Contour Plot Displays

You can modify a contour plot, once displayed, by using mouse motions to reposition the plot or using
the context menu that appears when you right-click the plot display. The context menu is not sensitive
to your mouse position within the plot; there is only one context menu for contour plots. Contour plots
also offer a toolbar because the mouse movements to control the 3-D positioning of the plot are less
intuitive.
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2.3.1. Zoom Options

The zoom options on a contour plot are limited to a stepwise zoom-in or zoom-out operation. The
Zoom to Fit option restores the contour plot to the initial sizing.

2.3.2. Export As

The Export As option allows you to export your plot to a pdf, jpg or png format file.

2.3.3. Tool Bar Options

Figure 2.16: Contour Plot—Context menu displayed
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From top-to-bottom as displayed in Figure 2.16: Contour Plot—Context menu displayed (p. 25), the
tool bar options are broken into 4 groups. All of the tool bar buttons have mouse-over tool tips. The
first 3 buttons provide the same Zoom In, Zoom Out, Zoom to Fit operations as the context menu.

The fourth button, as highlighted in Figure 2.17: Contour Plot—Set Contour Display Ranges (p. 26),
opens a dialog to adjust the X, Y, Z, ranges displayed and the bounds of the color scale associated
with the Z values.

Figure 2.17: Contour Plot—Set Contour Display Ranges

The next group of 6 buttons control the rotation of the 3-D image in the 3 dimensions. These opera-
tions are also performed with the mouse by clicking and holding the left mouse button while moving
the mouse.

The next 4 buttons control the translation of the 3-D image in the X and Y directions. You can also
perform these operations by clicking the left mouse button and moving the mouse—while holding
down the Alt key.

The bottom button gives you access to control the light source used to light the contour. There is
only one light source; multiple light sources are not currently supported.
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Chapter 3: Post-Processing Alternatives
This chapter discusses alternative methods for processing results other than the Ansys Chemkin Visualizer
or the Reaction Path Analyzer. Export to Microsoft Excel (Windows Only) (p. 27) discusses exporting the
data to Microsoft Excel for analysis and GetSolution Data Conversion Utilities (p. 29) discusses the Get-
Solution utilities to prepare the data from Chemkin output for some other form of analysis.

3.1. Export to Microsoft Excel (Windows Only)

An option in the Ansys Chemkin Visualizer allows you to export all the selected solution data to an Excel
workbook so Excel can be used to generate custom plots. This option serves as an alternative to
Chemkin’s native Visualizer on Windows platforms. The Use Excel to Post-Process option is available
on the Select Post-Processing Variables panel after you have chosen to plot results using the Analyze
Results node. If the option is selected when the Process Solution Data button is used, all the solution
data will be collected in a single unsaved workbook in Excel. For a nominal run, the workbook includes
the following worksheets:

• Basic solution data as selected by user in the Select Post-Processing Variables panel

• Single-point data (such as ignition delay time and flame speed) in a transient simulation or 1-D steady-
state simulation if selected

• Sensitivity data if selected

• Rate-of-production data if selected

For a parameter study, the workbook includes the following worksheets:

• Basic solution data collected from each parameter study run

• Single-point data collected from each parameter study run if selected

• Sensitivity data collected from each parameter study run if selected

• Rate-of-production data collected from each parameter study run if selected

• Single-point data vs. the parameters varied in the parameter study

• End-point data in a transient simulation or 1-D steady-state simulation vs. the parameters varied in
the parameter study

All the solution data loaded into Excel is in column-based format. Because Excel imposes a limit on the
number of columns in a single worksheet, data sets that exceed this limit will be automatically divided
up into subsets so that each subset will satisfy the limit. Please note that the contour data sets available
to Ansys Chemkin’s native Visualizer are not available to Excel because it cannot handle that type of
data.
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3.1.1. Excel Settings

Microsoft Excel security sometimes blocks processing Ansys Chemkin results. Follow these steps to
enable Chemkin processing in your Excel installation. From Excel, access File > Options and select
Trust Center and then Trust Center Settings. In the next screen, set the options to match those shown
in Figure 3.2: Adjusting Excel security settings for Chemkin results post-processing, step 2 (p. 29).

Figure 3.1: Adjusting Excel security settings for Chemkin results post-processing, step 1
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Figure 3.2: Adjusting Excel security settings for Chemkin results post-processing, step 2

3.2. GetSolution Data Conversion Utilities

As described in About This Manual (p. 1), post-processing of Ansys Chemkin simulations involves ex-
tracting and analyzing the data contained in the Solution Files (one per cluster in the reactor network)
and in the pre-parsed post-processor files (.ckcsv) produced by the Run Parameter Study Facility. The
Solution File is not directly readable, but there is a provided utility program called GetSolution[.exe] that
reads it and converts it into .ckcsv format. The .ckcsv format is a comma-separated text file that is directly
readable by scripts, but is organized in block structures for efficient use by the Visualizer. We also provide
the GetSolutionTranspose[.exe] utility to further convert the .ckcsv file format into a set of separate plot
set files with a more accessible column-based .csv format, compatible with Excel and other third-party
packages. The GetSolution utility (and transpose option) can be run from either the command-line or
from within the Chemkin Interface (under the Utility group or menu).
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Figure 3.3: GetSolution Data Flow

The post-processing arguments for GetSolution are described in Table 3.1: GetSolution Arguments (p. 30).
All arguments listed in the table are optional.

Table 3.1: GetSolution Arguments

DescriptionArgument

GetSolution will display the help information.-help

GetSolution will create a CKSolnList.txt file for user selections.
For more details about CKSolnList.txt, see text below.

-listonly

GetSolution will skip the sensitivity data in XML solution file.-nosen

GetSolution will skip the rate-of-production data in XML
solution file.

-norop

GetSolution will use mass fraction instead of mole fraction for
species composition (by default mole fraction is used).

-mass

GetSolution will export all species data sets including those
consisting of only zero values (by default the all-zero data sets
are skipped).

-all

GetSolution will specify a preference file that holds preferred
units.

-p

The name of the preference file used with the -p argument.
You will need to use the full path if the file is not in the
working directory.

preference_file

The name of the XML solution file, which must contain a .zip
suffix. You must use the full path if the file is not in the

XML_zipfile

working directory. If a file is not specified, the XMLdata.zip file
located in your working directory will be used.

The name of a text file containing abbreviations of all variable
names, which must contain a .csv suffix. This allows you to

abbrevi
ation_file

change the default labels of the variables used in the output
file’s data rows. You will need to use the full path if the file is
not in the working directory. An example file named
abbreviations.csv is provided in the data directory of your Ansys
Chemkin installation.

Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.30

Post-Processing Alternatives



3.2.1. Using the GetSolution Utility with Command Line Arguments Only

Please follow these instructions to run the GetSolution utility only:

1. Open a Command prompt or UNIX shell.

2. Make sure the full path to your Ansys Chemkin bin directory is included in your PATH environment
variable (see Ansys Chemkin Windows Environment or Chemkin Linux Environment in the Chemkin
Getting Started Guide).

3. Navigate to your working directory.

4. At the command line, type (one continuous line):

GetSolution [-help] [-listonly] [-nosen] [-norop] [-mass] [-all] [-p] [preference_file] [XML_zipfile] [abbreviation_file]

The bracketed words represent optional commands. See Table 3.1: GetSolution Arguments (p. 30)
for further details.

5. GetSolution generates a comma-delimited text file named CKSoln.ckcsv and places it in your
working directory. CKSoln.ckcsv  can be imported into third party software such as Microsoft® Excel®.

3.2.2. Using the GetSolution Utility with CKSolnList.txt File

Please follow these instructions to run the GetSolution utility with a CKSolnList.txt file:

1. Open a Command prompt or UNIX shell.

2. Make sure the full path to your Ansys Chemkin bin directory is included in your PATH environment
variable (see Ansys Chemkin Windows Environment or Chemkin Linux Environment).

3. Navigate to your working directory.

4. At the command line, type GetSolution -listonly  to create a CKSolnList.txt  file.

5. Edit the CKSolnList.txt  file to make user selections. See The CKSolnList.txt
File (p. 32) for a detailed look at the syntax of CKSolnList.txt.

6. At the command line, type (one continuous line):

GetSolution [-help] [-nosen] [-norop] [-mass] [-all] [-p] [preference_file] [XML_zipfile] [abbreviation_file]

The bracketed words represent optional commands. See Table 3.1: GetSolution Arguments (p. 30)
for further details.

7. GetSolution generates a comma-delimited text file named CKSoln.ckcsv and places it in your
working directory.
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If command-line arguments and the CKSolnList.txt are used together, command-line arguments will
override selections made in the CKSoln.txt file.

Note:

You can also create a CKSolnList.txt with only the selections you need and run GetSolution
to generate a CKSoln.ckcsv.

3.2.3. The CKSolnList.txt File

The CKSolnList.txt file allows you to create a detailed filter for the GetSolution file. Table 3.2: Summary
of Syntax Rules (p. 32) shows the syntax rules for a CKSolnList.txt file.

Table 3.2: Summary of Syntax Rules

DescriptionRule

Any text after a # character is considered comments.1

The following keywords are reserved: VARIABLE, UNIT, SPECIES, VAR, SEN,
ROP, FILTER, TOP, BOTTOM, MAX, MIN, ALL, NONE.

2

The initial section of the file handles variable selections. There are three global selection options:

VARIABLE VAR ALL/NONE  - select all variables or none

VARIABLE SEN ALL/NONE  - select all sensitivities or none

VARIABLE ROP ALL/NONE  - select all rate-of-productions or none

There are also selection options on a per-variable base:

VARIABLE  var_name var_flag sen_flag rop_flag

The flags can have three types of value:

0  - there is no data, so can not be selected

1  - is selected already, can be de-selected

3  - is de-selected already, can be selected

These two types of selection options can be used together to make the process more efficient. The
example below shows to extract temperature and its sensitivity and NO2 and its rate-of-production
but nothing else from a variable:

VARIABLE VAR NONE

VARIABLE SEN NONE

VARIABLE ROP NONE

VARIABLE temperature 1 1 0
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VARIABLE NO2 1 0 1

The next section handles unit selections. Each unit choice can be set using:

UNIT  var_type unit_choice

An example of variable types and their unit choices are shown below:

Time (sec) (min) (hr)

Distance (cm) (m) (inch) (ft) (mil)

Temperature (K) (C) (F)

A full list of unit choices can be seen in GetSolution help.

The next section handles the filter for top/bottom selection. You can pick the top n or bottom n
species, reaction sensitivities, and species rate-of-productions. Only one of the three choices, ALL,
TOP n, BOTTOM n, can be selected.

SPECIES ALL/TOP n/BOTTOM n

SEN ALL/TOP n/BOTTOM n

ROP ALL/TOP n/BOTTOM n

The next section handles the filter for species data based on mole fraction. The MAX and MIN specifies
the range of mole fraction. The default is MAX = 1.0 and MIN = 0.0.

FILTER MAX  max_value

FILTER MIN  min_value

3.2.4. The CKSolnTranspose Utility

The CKSolnTranspose utility can be used to convert the row-based CKSoln.ckcsv file to a set of column-
based *.csv files. A column-based file format is often easier to import into third-party plotting packages.
It is also necessary for use with the Import utility of the graphical Ansys Chemkin Visualizer. The CK-
SolnTranspose executable located in the bin directory of your Chemkin installation. If you have already
appended the bin directory to your local PATH environment variable, type the following command
to run CKSolnTranspose:

%CKSolnTranspose [-help] [-column N] [CKSolnFile]

where -help displays the command syntax information and -column N specifies the maximum
number of columns per output file. The default is 100 columns per file. We note that the Microsoft
Excel limit is 256.
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CKSolnFile is an optional file name for the row-based solution file generated by GetSolution. The
full path has to be included if it is not in the working directory. By default the file name is CKSoln.ckcsv.

Note:

Please note that 2-D contour data sets are ignored if they exist. Only 1-D (line) plot data
is included.

3.2.5. The CKSoln.ckcsv File

The CKSoln.ckcsv file produced by the GetSolution utility is composed of blocks of data. These blocks
are either rows of 1-D arrays of data or 2-D data structures. Each block begins with a label row that
provides either a plot set or a contour set name and then specifies the number of elements in the 1-
D array or 2-D matrix (for contour data). Array block labels are then followed by 1 or more rows of
array data with the data name, units (or empty parentheses), and data values. Contour block labels
are followed by 2 axis-rows and then the Z values for each (X,Y) tuple on a row by row basis. The Z-
variable and units are specified on the label_2D line.

For instance, these are two 1-D array block labels:

label, solution_no_1, 334
label, rate-of-production_for_solution_no_1, 334

These is one 2-D contour block labels and axes data (truncated):

label_2D, Temperature, (K), 5, 15
Axial_coordinate, (cm), 0.000000e+000, <4 more data values>
Cross-flow_coordinate, (cm), 2.220446e-016, <14 more data
values>

Note:

When there are more than 256 values (labels, units, data) per row, Microsoft® Excel® will
complain that it cannot completely load the data because it runs out of columns. You can
transpose the data, reduce it, etc., to eliminate this problem.

There is not a 1-to-1 correspondence between the Solution Sets listed in the Data Selection dialog
of the Ansys Chemkin Visualizer and the resulting label blocks in the CKSoln.ckcsv file; when adjacent
1-D arrays in different Solution Sets have the same length, we continue to append to the same block.
This results in fewer plot sets in the Plot X-Y selector, which makes it easier to plot data from different
Solution Sets at the same time.

The XMLdata.zip file is composed of a set of zipped files. Each zipped data file contains an .xml file;
but these .xml files are interdependent insofar as an xml <tag> may begin in one file and be closed
in the following file. For this reason, they may not display properly if examined one at a time. Each
of these .xml files is roughly 10 MB prior to zipping. The overall processing sequence is to extract the
zip files, sequentially open them one at a time to process the xml contents, and then to re-zip them
back into XMLdata.zip. If this process is interrupted (for instance, runs out of memory or disk space),
it can leave .zip and .xml files in the Working Directory. For this reason, the GetSolution utility always
does a "cleanup" step first. You may see messages saying Could Not Find XMLdata*.xml, or
similar. These are normal and mean there were no stray files needing to be deleted.
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Since the overall process is sequential, the data is extracted in blocks when the CKSoln.ckcsv file is
constructed. If we were only extracting one block of data, and it was not too large, it might have
been practical to transpose the data into columnar format in the .csv file. However, the different
blocks do not necessarily have the same length. At the time of writing block 1, we do not know how
many more blocks we will be writing. Therefore, it is not feasible to output the multiple blocks in
columnar format. This may not be immediately obvious to anyone who is looking at a simple problem
with only one block of data. See the cylindrical_shear_flow__cvd.ckprj sample problem for an example
of the complexity of having both 1-D and 2-D blocks of data in a .csv file.
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Chapter 4: Reaction Path Analyzer
The Reaction Path Analyzer is a feature that has been incorporated into Ansys Chemkin to provide
visualization of the inner workings of the chemistry model and to provide fundamental understanding
of reaction mechanism dependencies. The pathways leading to the formation of species are presented
in a single graphical interface that displays the relative importance of each reaction. The Reaction Path
Analyzer is available as a post-processing option in the Analyze Results panel, for any Chemkin reactor
model. After a successful simulation run, the option to select the Reaction Path Analyzer is available
from the Analyze Results node on the project tree.

4.1. Overview of Reaction Path Analyzer Display Panels

When the Reaction Path Analyzer is opened, a large primary window is visible which displays data and
has a side-panel that controls which data are displayed and how they are presented. The large primary
window is composed of three sections, as shown in Figure 4.1: The main Reaction Path Analyzer panel,
showing the Reaction Path Diagram, the Rate of Production area, and the Sensitivity area, and the
Solution tab of the Control panel. (p. 38): the Reaction Path Diagram, the Rate of Production Bar Graph,
and either the Sensitivity bar graph or the Forward and Reverse Rate-of-progress bar graph. Figure 4.2: The
Reaction Path Analyzer Control Panel, which controls what data is being displayed in the Reaction Path
Diagram. (p. 39) shows the control panel that displays on the right side, with options to change the
constraints used in generating and displaying the path diagram, based on the current Ansys Chemkin
solution. These components are described briefly below, while Using the Reaction Path Analyzer (p. 43)
contains instructions on how to modify the display characteristics.
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Figure 4.1: The main Reaction Path Analyzer panel, showing the Reaction Path Diagram, the Rate
of Production area, and the Sensitivity area, and the Solution tab of the Control panel.
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Figure 4.2: The Reaction Path Analyzer Control Panel, which controls what data is being displayed
in the Reaction Path Diagram.

4.1.1. Reaction Path Diagram

The Reaction Path Diagram displays species as well as reaction pathways connecting the species. The
relative sizing of the connecting pathways is related to the relative contribution of that pathway to
the net rate of production of the species. Path widths with the minimum rate of production corres-
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ponding to a line thickness of one, and the maximum rate of production scaled to the largest allowed
line thickness. Intermediate line thicknesses are determined on a log scale.

4.1.2. Rate of Production Bar Graph

Selecting either a species or a connecting pathway between species in the Reaction Path Diagram
will activate the lower left panel, reserved for the display of species rates of production. Selecting a
species will display all rates of production for the selected species whether it is a product or a reactant
in the reaction. Selecting a connecting pathway between any two species will populate the contents
of the graph with the contributing rates of production for all reactions contributing to the path selected.
All Rate of Production data are displayed in bar graphs as seen in the lower left region of Figure 4.1: The
main Reaction Path Analyzer panel, showing the Reaction Path Diagram, the Rate of Production area,
and the Sensitivity area, and the Solution tab of the Control panel. (p. 38), showing the relative con-
tributions of each reaction on a linear scale.

4.1.3. Sensitivity Bar Graph

Selecting a species in the Reaction Path Diagram will activate the lower right panel, displaying all
sensitivity coefficients that have been calculated for the selected species. If there are no sensitivity
data in the Ansys Chemkin solution file, no sensitivity bar chart will be displayed. When available,
data is displayed in bar-graph form, providing the normalized, relative sensitivity of the species to
each reaction, as shown in Figure 4.3: Sensitivity plot for the H2O2 species (p. 40).

Figure 4.3: Sensitivity plot for the H2O2 species

4.1.4. Forward and Reverse Rate Chart

Selecting a connection path in the Reaction Path Diagram will activate the lower right panel, displaying
all forward and reverse reaction rates for each reaction that is a contributor to the selected connection
path. As shown in Figure 4.4: Forward and reverse rate of progress chart (p. 41), the forward and reverse
rates are charted to show their relative sizes.
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Figure 4.4: Forward and reverse rate of progress chart

4.1.5. Control Panel

The Control Panel contains access to elements that modify the form of the Reaction Path Diagram
being displayed, as well as graphical tools to help determine which time or space solution point is
currently being displayed. These components of the Control Panel are described briefly below, while
instructions on how to use these components is provided in Using the Reaction Path Analyzer (p. 43).

4.1.5.1. Composition Bar Graph

The Composition display is a graphical representation of the local values for species at the selected
point in the Ansys Chemkin solution. The relative contribution of each species is displayed in a bar
graph chart as shown in Figure 4.5: Composition display (p. 41). The maximum species fraction that
occurs at any point in the Chemkin solution is displayed as a gray bar behind the black bar showing
the local value. By default, the composition bar chart is displayed on a linear scale, but this can be
changed to a log scale.

Figure 4.5: Composition display

4.1.5.1.1. Preferences Selection

To change user preferences for the Reaction Path Analyzer, click the Preferences tab, shown in
Figure 4.6: Preferences panel (p. 42). The Preferences panel allows the setting of options that
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dictate the behavior of the Reaction Path Diagram. The purpose of these options is described in
more detail in the following section.

Figure 4.6: Preferences panel
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4.2. Using the Reaction Path Analyzer

The Reaction Path Analyzer provides you with many options to control the way the reaction network
is generated and displayed in the Reaction Path Diagram. The purpose and impact of each control is
described briefly here.

4.2.1. Maximum Number of Species Displayed

This control sets a maximum number of species displayed in the Reaction Path Diagram. By default,
species are ranked according to the maximum rate of depletion of all species at the particular point
selected in the Ansys Chemkin solution. The species with the maximum depletion rate determines
the top of the "tree" for the Reaction Path Diagram. Other species that will be included in the display
are then chosen according to a similar ordering, with the added constraint that they be connected
to the first species selected. In addition to this default behavior, the target (top of the tree) species
can be selected explicitly in the Control Panel, through several options described below. However
the tree is determined, no more than the Maximum Number of Species will be displayed on the
Reaction Path Diagram at any one time. In this way, the size of the diagram can be controlled by this
option.

4.2.1.1. Start and End Species

Species of interest can be selected in the Species List tab as shown in Figure 4.7: The Species List
tab for selecting species available for start and end. Preferred species persist beyond the application
lifetime. (p. 44). By default the reactants are available for selection. Species highlighted in the
Species List tab on the Solution panel are available in the Species Selection tab, where they can
be dynamically selected and deselected as the Start and/or End Species used to generate the Re-
action Path Diagram. There are three options to determining the Reaction Path Diagram using the
Species Selection Start and End Species :

• Select only a Start Species

• Select only an End Species

• Select both a Start and End species
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Figure 4.7: The Species List tab for selecting species available for start and end. Preferred
species persist beyond the application lifetime.

Selection of only a Start Species will generate a diagram with the given species as the origin, and
additional species are added to the diagram according to the magnitude of the rate-of-production
(ROP) of species that can be connected to one of the existing species on the diagram. This growth
of the tree is continued until the maximum number of species displayed is reached. A schematic
of this procedure is provided in Figure 4.8: The first four steps when generating a diagram from the
Start Species (p. 45).
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Figure 4.8: The first four steps when generating a diagram from the Start Species

Selection of only an End Species results in analogous behavior to the Start Species selection, except
that the species will be added to the Reaction Path Diagram according to ROP channels leading to
the formation of the existing species on the Diagram. The steps for building the tree in this case
is shown in Figure 4.9: The first four steps when building a diagram from an End Species (p. 46).
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Figure 4.9: The first four steps when building a diagram from an End Species

The selection of both Start and End Species will cause the inclusion of species connecting the
maximum ROP route from Start to End. Additional species are added to the Diagram according to
maximum ROP pathways originating from the species already in the Diagram and that are along
the trail connecting the Start and End Species. This is illustrated in Figure 4.10: The first two steps
when building a diagram from the Start and End Species (p. 47).
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Figure 4.10: The first two steps when building a diagram from the Start and End Species

4.2.2. Elemental Restriction

The species displayed in the Reaction Path Diagram can be restricted to the ones containing a specified
element. The only pathways that will be displayed in the Diagram will also be similarly restricted to
following the given element. By default, all elements are allowed in the Reaction Path Diagram con-
struction.

4.2.3. Maximum Line Thickness

The maximum line thickness slider control will set the maximum line thickness displayed in the Reaction
Path Diagram. Since ROP values vary over orders of magnitude, the scaling of lines is logarithmic. The
power of the logarithm is chosen so that the minimum corresponds to one pixel width, and the
maximum ROP corresponds to the user-specified maximum line width.

4.2.4. Solution Data Point Selection

Solution data points are selected from a sub-section of the Control Panel, below the Line Thickness
slider bar. Ansys Chemkin generates solutions that vary with one or more independent variable (for
example, time, distance or some varied parameter). The Reaction Path Analyzer therefore provides a
Solution selection interface that allows dynamic selection of a point along a solution varying in one
dimension. The Solution point selected will determine the local values of ROP that are used to generate
the Reaction Path Diagram. Sub-components of the Solution panel include Solution Selection, Depend-
ent Variable Selection, and the Data Point Display and Selection. These are described briefly below.

4.2.4.1. Solution Number Selection

The Solution Selection interface allows the selection among several solutions that may be contained
in a single solution file. For example, if a 1-D simulation was run with continuations, is allows the
selection of which continuation solution will be analyzed. In the Multizone model it will allow the
selection of an individual zone, as well as the zone average. Similarly for the Spark Ignition (SI)

47
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Using the Reaction Path Analyzer



model, the unburned, burned, and average zones are available here for selection. IIf there is only
one solution contained in the Ansys Chemkin solution file, this option will be disabled.

4.2.4.1.1. Y Variable Selection

The Y Variable pull-down menu allows selection of the dependent variable that will be displayed
in the graph window below the Selection menu. By default, this is set to temperature, but any
other solution variable that is usually available in the Ansys Chemkin Visualizer can be selected
instead.

4.2.4.1.2. Data Point Display and Selection

Within the graph that displays the selected Y Variable plotted as a function of the independent
variable, an "X" location for the solution can be selected. Clicking inside of the X-Y plot window,
shown in Figure 4.11: Data Selection window (p. 48), will set the point of interest, and a new
Reaction Path Diagram will be generated for that location. In addition, pressing the right or left
arrows on your keyboard will increment or decrement the point of interest by one stored solution
point, when the Control Panel is in focus on your screen. This allows finer control of the location.
By default, the location selected is at the start of the solution, for example, at X (time or dis-
tance)=0.0. The location selected, in terms of (X,Y) values is displayed below the graph.

Figure 4.11: Data Selection window

4.2.5. Preferences

There are several User preferences that can alter the way the automatic generation of the Reaction
Path Diagram is performed and displayed. The three panels of the Preferences dialog are shown in
Figure 4.6: Preferences panel (p. 42), and the details of each option are described below.

4.2.5.1. General Preferences

General preferences are organized into three categories: How the species are laid out in the diagram,
how the reaction connections are assembled in the diagram, and how the compositions of associated
bar charts are organized.
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4.2.5.2. Layout Options

This group of controls alters the layout and dimensions of the Reaction Path Diagram. Controls are
available for setting the layout manager, the zoom, font size, and borders on species.

4.2.5.3. Layout Attributes

The layout manager dictates the method used to determine the position of the species in the Re-
action Path Diagram. This fundamental layout technique alters the format of the display, and can
either improve or hamper the visualization of reaction paths, depending on the chemistry and
results of the model. There are two options for layout handling, either the Tree Method or the
Hierarchical Method.

The Tree layout uses a generated ancestor tree to determine the primary layout of the diagram
panel. Each child is determined by a positive ROP leading from a chosen species to another species.
The layout of the panel is chosen so that the progeny that can be reached by one species is max-
imized. In the ancestor tree layout, all depleting pathways exit from the bottom of a species, and
all formation pathways enter at the top of a species.

GraphViz [1] (p. 57) is open-source graph visualization software. The program used by the Reaction
Path Diagram for this type of layout is Dot. The Dot  executable makes hierarchical, or layered
drawings of directed graphs. The layout algorithm aims edges in the same direction (top to bottom,
or left to right) and then attempts to avoid edge crossings and reduce edge length. GraphViz is
open source, CPL-licensed software. It may be redistributed, without cost, and in other software
distributions, as long as the license terms are met. The Reaction Path Analyzer assumes that the
Dot executable is accessible on the path. If that is not the case, then add the GraphViz bin directory
to your path environment variable.

4.2.5.4. Zoom (%)

The zoom level will change the relative sizing of all components in the Reaction Path Diagram.

4.2.5.5. Font Size

Changing font size will alter the size of font for labels displayed in the Reaction Path Diagram.

4.2.5.6. Borders on Species

This option will put boxes around the species in the Reaction Path Diagram.

4.2.5.7. Reaction Connection Options

There are several settings to modify how the reactions connecting species are displayed within a
reaction path diagram. These controls modify the reaction line thickness, whether or not joints are
added in a line, line labels, and the maximum magnitude of the displayed line.

4.2.5.8. Line Thickness

Changing from Absolute ROP to Relative ROP will alter the relative sizing of the connecting pathways
between species. The relative size of each arrow will be normalized by the sum of all ROPs exiting
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a source species. The Constant ROP line thickness will leave all lines at a constant thickness inde-
pendent of their magnitude.

4.2.5.9. Straight or Jointed Lines

Selecting Straight lines will make all reaction pathways connecting species into single lines within
the Reaction Path Diagram, making direct connections between the source and destination species.
The (default) Jointed Line option causes lines to be wrap around the species and avoid overlap.
This option applies to both the Tree and GraphViz layouts.

4.2.5.10. Line Labels

The labels on reaction lines can be composed of either the absolute magnitude of the rates in a
connection or a relative magnitude of the rates. Additionally, the label can include information
about side species associated with a reaction pathway. The concept of a side species is explained
in Side Species Preferences (p. 50). These labels appear with mouse hovering, mouse selection, or
can be turned on for all reaction connections.

4.2.5.11. Composition Options

Composition controls set the data limitations of bar charts. The maximum species and maximum
reactions set the number of entries in sensitivity, rate of production, or composition bar charts. Log
scale will scale the bars on the Composition Bar Chart on the Control Panel using a logarithmic,
rather than linear, scale. For this option, the minimum composition value is represented by a zero-
length bar.

4.2.6. Side Species Preferences

Side species are components such as radicals that are important in the reactions connected on the
path analysis diagram, but should not be characterized as source or target species on the reaction-
path diagram. Common examples of such side species include the hydrogen radical, hydroxide radical,
oxygen radical, and the peroxy radical. You can select which species should be designated as side
species in the diagrams, using the tabs shown in Figure 4.6: Preferences panel (p. 42).

Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.50

Reaction Path Analyzer



Figure 4.12: Path diagram. With connections colored according to the presence of a side species
in a reaction

4.2.7. Color Preferences

The arrow color and species color can be set as a preference. Changing these colors alters the coloring
scheme of the Reaction Path Diagram. The second color option will color a reaction connection log-
arithmically according to heat rate of production, with positive heat being red, and negative heat
being blue. The remaining color choices indicate which of these side species are involved in a reaction
line that connects two species in the diagram. An example of a diagram colored by side species is
shown in Figure 4.12: Path diagram. With connections colored according to the presence of a side
species in a reaction (p. 51).

4.2.8. Help Menu

The commands under Help on the Control Panel include a link to user documentation as well as an
About menu.

4.2.9. Export Options

Exporting raw data from the ROP bar chart, the Sensitivity bar chart, or the Forward/Reverse Rate of
Progress chart is available from the File > Export menu or ribbon. Data in the chart are saved to a
new file in comma-space-delimited (csv) format.
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4.2.10. Printing Options

Printing of the Reaction Path Diagram, the ROP bar chart, the Sensitivity bar chart, or the Forward/Re-
verse Rate of Progress chart is available in the File > Print option of the Control Panel. All charts are
automatically scaled to fit a single page.

4.3. Reaction Path Analyzer Example

In the evaluation of a mechanism, the Reaction Path Analyzer provides graphical descriptions of the
pathways of formation in a mechanism. A common example of the use of reaction pathway analysis is
in studying the decomposition in a methane air flame. To verify the Reaction Path Analyzer against
such a benchmark, then, a methane combustion mechanism [2] (p. 57) was investigated with assistance
from the Reaction Path Diagram. A Burner Stabilized Flame simulation was performed with Chemkin
using the USC mechanism from Wang [2] (p. 57). Conditions are: atmospheric pressure, 300-K inlet
temperature, and a methane-air equivalence ratio of one. From previous studies, it is expected that
depletion of methane species in the pre-flame region occurs primarily through hydrogen abstraction
by hydroxy radical. Later in the warmer region of the flame other hydrogen abstraction reactions begin
to match the magnitude of the hydroxyl radical hydrogen abstraction reaction.

A Reaction Path Diagram for this case is shown in Figure 4.13: Methyl decomposition pathways (p. 53).
The diagram is displayed at a temperature of 1400 K. Analysis of the diagram indicates that the main
pathways of decomposition of methyl radical is to the formation of the excited CH2 species, which then

decomposes to form CH2 O and CH3 O. Other channels lead directly from methyl radical to the radical-

radical recombination to ethane. The primary depletion of ethane is through the hydrogen abstraction
to ethyl radical, which through radical-radical recombination with a methyl radical leads to the formation
of propane. In the hotter region of the flame, these molecular-weight growth reactions are less favored.
All of this is consistent with previous, published findings.
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Figure 4.13: Methyl decomposition pathways
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Appendix A. Auxiliary Information

A.1. Solution File Format

The XMLdata.zip is a standard zip file (you can open it with WinZip or any other zip utility) that contains
the following files:

• chemkindata.dtd -- A DTD document defining the structure of an XML file

• XMLdata-1.xml.zip -- A zipped XML document which serves as a checkpoint for GetSolution utility
(internal use only)

• XMLdata0.xml.zip -- A zipped XML document containing solution size information and solution
header

• XMLdata1.xml.zip -- A zipped XML document containing chemistry mechanism data

• XMLdata2.xml.zip -- A zipped XML document containing solution data

• And possibly many more solution-data zipped XML documents

The purpose of a DTD (Document Type Definition) is to define the legal building blocks of an XML
document. It defines the document structure with a list of legal elements. The chemkindata.dtd file
documents the file format for the Ansys Chemkin .xml output files. For more information on DTD files,
the web tutorial at https://www.w3schools.com/xml/xml_dtd_intro.asp is a good resource.

If the XML file’s contents were small, we would simply store a single XML file. However, since solution
files can be quite large (sometimes exceeding 100 MB even when zipped), we process what is logically
and conceptually a single XML file as a series of separate files. Each of those files is kept zipped until
needed.

Breaking a single XML file into a series of separate files poses some problems for standard XML file
readers because each file is not, by itself, a proper XML file (because opening or closing tags may be
in different files). So, we have a more complex XML file reader module that drives the open/parsing/clos-
ing of the XML files. Since XML files store information in character mode, the processing of an XML
solution file is slower than processing of binary data stored in save.bin. In exchange for the slower
performance, we get cross-platform portability, improved size scalability, and, most-importantly, cross-
application file format consistency. This lays the foundation for creating networks of heterogeneous
reactor models, which we have made much more accessible since Ansys Chemkin 4.

Occasionally an XML file will require more RAM/swap space than the system has available and our XML
reader module (part of GetSolution) will abnormally terminate. Or, for some reason, the user will kill an
Aurora or other application executable job; or the Aurora or other application executable will die due
to a bug or system limitation. Any of these reasons can leave XMLdata*.xml files in unzipped states.
These files are essentially temp files and need to be deleted prior to the next use of the XML reader
module contained in GetSolution and in Ansys Chemkin.

55
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

https://www.w3schools.com/xml/xml_dtd_intro.asp


This XML reader (and writer) module is a complex, internal part of our Ansys Chemkin program suite
and can not be invoked directly by any user-written programs. We make the GetSolution program
available for use in scripting/batch applications. If for some reason you want more details about the
internal XML structure contained in the XMLdata.zip files, please consult the DTD document.
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